
Вступление:
полно программ, созданных специально для проектирования ткацких изделий, печати на тканях и создания трикотажных полотен. Они позволяют
рассчитать количество материала и заправить станок определённым сырьём.Позволяют манипулировать с эскизом. Поправлять или творить.

Например, известны программы: Textronics Design Dobby:
NedGraphics Jacquard Pro
Pointcarre
AVL Looms WeavePoint
ProWeave

Ещё в 2018 году индийские журналы писали о том, что искусственный интеллект приходит в текстильную отрасль.

*Indian Textile Journal (ITJ) is a leading publication dedicated to the textile industry in India. With a rich heritage spanning over 133 years, ITJ has established itself as a trusted
source of information and insights for professionals and enthusiasts in the textile sector.
_____________________________________________________________________________________________________________________________________________________________________________
Все они по-своему прекрасны, но изучать их есть смысл с привязкой к конкретному производству. Я была бы рада такой возможности, по крайней мере.
Но многое из того, что эти программы предлагают, есть в Photoshop, со времён сотворения Photoshop.
Это такие базовые вещи, которые надо уметь делать, работая над орнаментом: симметрия, выравнивание, поворот, расчет размера, привязка к сетке,
перекрашивание, поворот, рисование, редактирование. Как правило, весь этот набор действий предшествует выводу проекта непосредственно в производство, на
станок. Это эскизная часть. Её начало, - в первой обработке эскиза и творческой обработке.
Те задачи, которые может решать Photoshop, - шире производственных. Нам будет доступен смысл процессов, а в дальнейшем можно будет постичь их в
специализированной программе, если придётся. Помечу здесь, что с некоторой неуверенностью говорю эти слова, так как дизайнера теперь следует называть
“составитель задач для ИИ”.

Одной из задач, которые умеют решать вышеупомянутые программы, является сокращение количества цветов. Эта тема является частью нашей большой темы -
Перекрашивание. Рассмотрим старомодные способы в надежде, что ещё не поздно…

Перекрашивание - Сокращение количества цветов - в Photoshop
в Illustrator

______________________________________________________________________________________________________________________

# сокращение количества цветов, CLUT (Color LookUp Table), swatches в Photoshop
Wikipedia
сохранение своих образцов и обмен между файлами

Image > Mode > Indexed Color

Упражнение Исходники

https://www.textronic.com/design-dobby.html
https://nedgraphics.com/
https://www.pointcarre.com/
https://avllooms.com/products/weavepoint-1
http://www.proweave.com/
https://indiantextilejournal.com/software-used-in-textile-design/
https://indiantextilejournal.com/
https://en.wikipedia.org/wiki/Color_quantization
https://youtu.be/TYEMzsrXmyw?si=F_uLs0S4tHehNieR
https://fotorelax.ru/


Как правило, мы начинаем работу, имея файл в цветовом пространстве RGB, 8 bit, что составляет более шестнадцати миллионов цветов.
8 бит на канал — это 256 цветов, следовательно, три канала по 256 оттенков смогут вместе отобразить 256х256х256=16 777 216 оттенков.
И мы понимаем, - не все они различимы, - настолько близки.

Как нам уменьшить количество цветов?

Это довольно хитрый вопрос, так как формально, - ответ может быть таким: произвести цветоделение.
Т.е., - мы переведём RGB в CMYK и получим 4 цвета, ибо “режим хранения цветоделённых файлов, - это CMYK.
Вот перечисление всех возможных в Photoshop цветовых пространств:

1. RGB mode (миллионы цветов)
2. CMYK mode (4 печатных цвета)
3. Index mode (256 цветов)
4. Grayscale mode (256 серых)
5. Bitmap mode (2 цвета)

Поэтому, давайте договоримся, что под уменьшением количества цветов мы будем понимать совокупность
уменьшения количества цветовой информации и в арт объекте и в его цифровом описании. Также, нам
придётся помнить, что RGB - это пространство монитора, поэтому любой “цвет” пересчитывается в него на
экране.

Если мы собираемся в качестве поиска цветового решения “поиграть с цветом”, не задумываясь о количестве, -
для этого в Photoshop лучше использовать мощь инструмента “Кривые” или “Уровни”, а также “Карту
градиента”..

Adobe Illustrator предлагает механизм, управляющий количеством цветов в композиции, именно
перекрашивающий картинку, очень удобный.

Но он предназначен для векторных объектов, а что нам делать, если у нас фотография в наличии, как источник
всей информации о цветах, а нам надо получить из неё выборку цветов, к примеру 5-10 и покрасить этими
цветами другие объекты замысла, или создать что-то именно в этом колористическом ключе. В Photoshop эту
задачу можно выполнить, если преобразовать его в цветовое пространство Indexed.Этот маневр позволит получить выборку цветов в виде файла в формате .ACT, и
позже в том же Photoshop преобразовать его в .ASE, что позволит перенести тот же цвет в Illustrator.

Цветовое пространство Indexed

Для художников, работающих в текстильной промышленности, сокращение количества цветов в эскизе равнозначно сокращению числа печатных валов,
использованных чернил, сеток, рам, времени и производственных рисков.

И основная задача индексированного режима, именно оптимизация цветовой информации для экранов и устройств с различными возможностями, т.е.
он и в плане цветопередачи выгоден, и в плане “веса”, - он “лёгкий”, поэтому до сих пор рекомендуется использовать этот режим для web-контента. Вы



можете убедиться сами: при экспорте картинки из Photoshop в .GIF откройте два окна рядом, - виджет экспорта позволит сравнить её “вес” в разных
форматах. Потому, что .GIF принудительно переводит всё в Индекс

В более ранних версиях Photoshop пользователь мог управлять количеством сохраняемых цветов и снимать таблицы цветов при сохранении файла.

Я предлагаю вам пользоваться функцией перевода в Indexed.

Мы не должны упустить интересные возможности, которые нам, как представителям прикладного искусства, могут пригодиться.

Мы получим:

1. сильно уменьшим вес файла
2. получим CLUT (Color Lookup Table) - таблицу цветов
3 преобразуем CLUT в SWATCH, сохраним, чтоб впоследствии открыть в Illustrator
4. научимся управлять графическими эффектами с помощью настройки связи между разрешением файла и методом преобразования в Indexed
5. научимся применять CLUT как шаблон

Упражнение:

1. открыть любую фотографии в Adobe Photoshop и перевести её из режима RGB Indexed: Image > Mode > Indexed
2. пройти максимальное количество проб настроек в диалоге Indexed Color
3. составить таблицу цветов
4. сохранить таблицу цветов в образцы программы
5. загрузить сохраненные цветовые таблицы в Adobe Illustrator
6. перекрасить в Illustrator векторный объект в цвета из вами импортированной цветовой группы через поиск её в библиотеках программы и применением
соответствующей настройки в окне диалога Artwork Recolor
7. сохранить исходники и производные в одну папку - она будет учитываться в зачете

Исходники

Работы студентов:

https://youtu.be/TYEMzsrXmyw?si=F_uLs0S4tHehNieR
https://fotorelax.ru/
http://avroracreateser.ru/rabotyStudentov.html


Иллюстрация слева показывает диалог настроек трансформации полноцветного изображения. Все перечисленные окна, - и Palette, и Colors, и Dither, - существенно
меняют результат. На фрагменте вы видите, как программа преобразовала довольно сложный рисунок лица в набор узоров, очень напоминающих текстильный
плоскостной пересчет нитей на ткацком станке. В некоторой степени этим процессом можно управлять, меняя в позиции Dither/Дизеринг.

Dither/Дизеринг/Псевдотонирование

Уменьшение количества цветов меняет качество изображения, не всегда удачно.Самым значимым фактором, от которого зависит результат, - можно считать
используемую при конвертации палитру. Второй участник процесса, - алгоритм дизеринга. Он отвечает за “игру пятен”, за детали. Проблема потери деталей
решается применением дизеринга, например, - по алгоритму Флойда — Стейнберга (англ.)

Дизеринг минимизирует потери деталей и существенно улучшает общее восприятие изображения без увеличения количества используемых цветов.

Поэтому в диалоговом окне конвертации, мы можем и должны искать наилучшие варианты для комбинации выбора палитры и способа дизеринга:

это строчки Palette и Dither. Обратите внимание!!! Если, переведя файл в Индексированный режим, мы изменим его разрешение, - мы получим другой узор.

https://en.wikipedia.org/wiki/Floyd%E2%80%93Steinberg_dithering80%93Steinberg_dithering


Если, переведя файл в Индексированный режим, мы изменим его разрешение, - мы получим другой узор. Я предлагаю использовать диалог Image Size, а не
фильтры. Image Size работает и в “ индексе”, а для работы с фильтром Pixelate > Mosaic требуется перевод изображения снова в RGB.

Мы можем менять разрешение файла до конвертации или после или не менять. В этом и состоит творческая игра каждого отдельного случая.

Видео с примером

Можно сказать, что производству текстильных эскизов из простых фотографий могут очень способствовать : перевод RGB в Indexed и различные
алгоритмы дизеринга.

Что ещё полезного можно почерпнуть, находясь в режиме индексированных цветов?
Перевод изображения в режим INDEXED открывает доступ к таблице цвета, иными словами, - мы можем получить перечень цветов из конкретного файла: пусть это
собственный труд или случайная фотография. В самом низу Image > Mode > Color Table, а открыв его, справа в настройках находим команду SAVE и сохраняем его
(см. видео).

https://www.youtube.com/watch?v=t0yor8Ec3i8
https://www.youtube.com/watch?v=TYEMzsrXmyw


Несколько примеров: фотографии из свободных источников

Если вы посмотрели видео, вы уже знаете, что в индексированном режиме изображение приобретает свой перечень цветов Color Table, меняя цвета в котором, вы
можете менять их по всему пространству.
Также, полезно помнить, что мы не обязаны хранить файл и далее в режиме Indexed. Экспортировать его в .png не слишком выгодно, - в .gif-как ни странно, чревато
тем, что это изображение не будет универсальным.
Неожиданной особенностью режима индексированных цветов оказалось то, что они играют с восприятием. Дробление вызывает оптические эффекты по мере того, как
мы удаляемся от изображения.

https://fotorelax.ru/interesnye-fotografii-5/


Фотографии автора

В этом же блоке я хочу рассказать о приёме деления изображения на цветные квадратики и прямоугольнички в обеих программах: Photoshop и Illustrator, поскольку мне
видится, что они также очень полезны при переводе какого-либо виртуального изображения в материальную вещь.



Если первый принцип изменения паттерна в индексированном состоянии - это изменение количества пикселей на дюйм (разрешение файла), при сохранении величин
сторон. В RGB этот трюк не пройдёт - произойдёт лишь укрупнение сетки из квадратов. Такая процедура станет аналогична фильтру “мозаика”.
Здесь надо остановиться и уточнить, что сам по себе фильтр Pixelate > Mosaic -
мощное средство, с помощью которого можно в RGB создать из изображения палитру образцов, просто укрупняя фрагменты , а потом вручную сняв цвета в в палитру
образцов и сохранить для обмена без процедур пересчёта.
Каким именно путём идти, во многом зависит от задачи. Если нужны только образцы, то Window > Swatches > New Swatch Group
Если какие-то поиски фактур, мне кажется, Indexed предлагает неплохой метод.

Подытожим эту часть: в Photoshop именно режим Indexed предоставляет возможность управления количеством цветов в файле.
Побочным эффектом работы алгоритма сжатия цветов является узор, образуемый сочетанием “шашечек”-пикселей. В связи с этим у нас возникает возможность для
создания графических эффектов, которые работают именно в этом режиме.

На этом первую часть считаю завершённой, переходим к Illustrator.
В первом видео этой темы уже мы говорили об инструменте перекрашивания цветов в Illustrator, но в рамках темы обмена.

У Illustrator есть чёткий алгоритм задания нужного количества цветов нужной гаммы.

Самый простой, наверное, - задать нужное количество цветов при трассировке. Второй способ - через палитру перекрашивания задать нужное количество цветов, либо
провести пользовательский шаблон с заданным количеством цветов. Оба приёма описаны в видео, по которому я предлагаю сделать упражнения.

Упражнение:`
______________________________________________________________________________________________________________________________________________

После выполнения трёх упражнений,ссылки на которые представлены в этой статье, студент будет уметь перекрашивать свои эскизы в заданное
количество цветов в растровой и векторной форме.

Санкт-Петербург, август 2023
______________________________________________________________________________________________________________________________________________
Примечание: специализированные ткацкие программы, такие, как Pointcarre владеют способом пересчёта любого изображения в имеющийся у них в
каталоге образец ткацкого переплетения (вида ткани). Также они непременно предлагают пользователю и функцию уменьшения количества цветов или их
замены на специализированные цвета PANTONE и других библиотек.

https://www.youtube.com/watch?v=d3KcZEZIVSE
https://www.youtube.com/watch?v=hVsqDbRGhZ8
https://pantone.com.ru/

